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Quick Reference Guide for Teachers: Classroom Manager 
 
The Classroom Manager is a bundle of HeadMaster Pro features that simplifies your classroom administration. 
As a teacher, you can track, and store information related to the classes you teach. With this quick reference guide, you 
can learn some of the most common tasks that you'll perform at the beginning of the school year to get set up as well as 
the daily tasks that you'll perform throughout the school year. 
When you log in to HeadMaster, the Calendar tab displays. On the Calendar tab, you can view your class assignments, 
reminders, and a calendar. 
For more detailed information, see the HeadMaster User Guide.
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Determine the Type of HeadMaster User You Are 
 
This quick reference guide is for teachers. But there are several different ways for teachers to access and use the 
HeadMaster program, and not everyone is clear about that. So, let's briefly cover each of those methods in order to 
help you understand. 

• Your school can have you set up with a HeadMaster desktop account. This means that you have a copy of 
HeadMaster installed on your desktop PC or laptop. You log in to that local install of HeadMaster and 
perform your tasks. For more information, see the HeadMaster User Guide. 

• Your school can have you set up with a HeadMaster OnDemand account as your primary means of 
accessing HeadMaster. With HeadMaster OnDemand, you have full access to your HeadMaster data via the 
internet. With HeadMaster OnDemand, you always have the latest software version and you're viewing and 
editing your live data. For more information, see the OnDemand User Guide. 

• Your school can have you set up with a HeadMaster Online account in addition to your desktop account. 
This means that you have view-only access to your HeadMaster information, typically via a link on your 
school's website. Your information that you view is current with the latest HeadMaster upload that your 
school has performed. All you need is an internet connection and you can log in from anywhere on most any 
mobile device. For more information, see Log into HeadMaster Online. 

 

 
 

  

  

   

Tip: If you’re still not sure about what kind of HeadMaster account you have, please consult your school’s 
HeadMaster administrator. 
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Locate Your Tasks 
 
The Home tab features the Home screen which contains shortcuts to your most common tasks. You can add or 
delete shortcuts on the Home screen. You can also minimize any windows that you open on the Home screen. 
 
The Home tab is divided into three sections: 

• Main Menu – Access principal areas of the program such as students, parents, and teachers. Also, enter or 
view assignments and reports.  

• Assistants – Locate program assistants that help you add or update data, such as post grades, student 
attendance, or skills.  

• Other – Locate tools and special helps, such as lesson plans, correspondence, behavior, and reminders.  
 

  

Useful Information: The School Attendance, Check In/Out, and Check In/Out Maintenance options are not 
available unless you’ve been given access by your administrator.  
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Create Your Lesson Plans 
 
You can create, edit, and print your lesson plans. You must be logged in to HeadMaster with a teacher login in order 
to create or edit lesson plans.  
 
To save time, you can create one set of lesson plans for a subject and copy the plans over to any other sections of 
that subject.  
 
Lesson Plans can be viewed in Month View, Week View, or Grid View. After you create your lesson plans, you can 
print a daily or weekly lesson plan report.  
 
Month View 
 
The Month View gives you an overview of how your month looks with lesson plans. All subjects are listed for every 
day that those subjects are taught. For classes with a single subject (upper grades/High School) you will see the start 
time for those subjects. A blue dot beside the subjects means that that subject has a lesson plan for that day. 

1. On the Home screen, click Lesson Plans. 
2. Click Month – 5 day or Month – 7 day. 
3. Click a subject that doesn't have a blue dot beside it. 
4. On the right sidebar, enter a Title. This is required. 
5. Optional: In the Link field, you can enter a URL (web address) to be easily accessed while using a SMART or 

Promethean Board. 
6. Optional: Enter Objectives. 
7. Optional: Enter Procedures. 
8. Optional: Enter Homework. 
9. Optional: Enter Materials. 
10. To save the lesson plan, click Save. 
11. To enter more lesson plans, repeat steps 3-10. 

 
Copy a lesson plan in month view 

1. On the Month – 5 day or Month – 7 day view, single-click the lesson plan you want to copy. 
2. At the top of the right sidebar, click Copy. 
3. Single-click the lesson plan to which you want to paste the copied lesson plan. 
4. Click Paste. You can paste the copied lesson plan to as many subjects as needed.  

 
Copy a lesson plan from a teacher in month view 

1. On the Month – 5 day or Month – 7 day view, from the Teacher drop-down menu, select the teacher from 
which you want to copy lesson plans. 

2. Single-click the lesson plan you want to copy. 
3. At the top of the right sidebar, click Copy. 
4. From the Teacher drop-down menu, select your name. 
5. Single-click the lesson plan to which you want to paste the copied lesson plan. 
6. Click Paste. 
7. To copy more lesson plans from other teachers, repeat steps 1-6. 
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Week View 
 
The Week View lets you see a week a time for one subject. You can easily move lesson plans from one day to 
another if needed. 

1. On the Home screen, click Lesson Plans. 
2. Click Week. 
3. Select a specific week by date or Week #. 
4. From the Subject drop-down menu, select the subject for which you want to create a lesson plan. 
5. Select a day that doesn't have a lesson plan. 
6. Enter a Title. This is required. 
7. Optional: In the Link field, you can enter a URL (web address) to be easily accessed while using a SMART or 

Promethean Board. 
8. Optional: Enter Objectives. 
9. Optional: Enter Procedures. 
10. Optional: Enter Homework. 
11. Optional: Enter Materials. 
12. To save the lesson plan, click Save. 
13. To enter more lesson plans, repeat steps 4-12. 

 
Copy a lesson plan in week view 

1. On the Week view, select the day you want to copy. 
2. On the toolbar, click Copy. 
3. Single-click the lesson plan you want to paste the copied lesson plan to and select another day or subject to 

paste the lesson plan to. 
4. Click Paste. You can paste the copied lesson plan to as many subjects as needed.  

 
Copy a lesson plan from a teacher in week view 

1. On the Week view, from the Teacher drop-down menu, select the teacher from which you want to copy 
lesson plans. 

2. Select a specific week by date or Week #. 
3. From the Subject drop-down menu, select the teacher’s subject from which you want to copy the lesson 

plan. 
4. Select the lesson plan you want to copy, then on the toolbar, click Copy. 
5. From the Teacher drop-down menu, select your name. 
6. Select a specific week by date or Week #. 
7. From the Subject drop-down menu, select subject for which you want to paste the other teacher’s lesson 

plan. 
8. Locate the day to which you want to paste the teacher’s lesson plan, click Paste. 
9. To copy more lesson plans from other teachers, repeat steps 1-8. 
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Grid View 
 
The Grid view allows you to sort and filter your lesson plans. You can also view lesson plans by a specific date range. 
Locate a teacher by using the Teacher drop-down menu or by using the Search field. 

1. On the Home screen, click Lesson Plans. 
2. Click Grid. 

3. On the right sidebar, click New  . 
4. From the Calendar window, select a subject. 
5. On the Calendar, select a date. 
6. Enter a Title. This is required. 
7. Optional: In the Link field, you can enter a URL (web address) to be easily accessed while using a SMART or 

Promethean Board. 
8. Optional: Enter Objectives. 
9. Optional: Enter Procedures. 
10. Optional: Enter Homework. 
11. Optional: Enter Materials. 
12. To save the lesson plan, click Save. 
13. To enter more lesson plans, repeat steps 3-12. 

 
Copy a lesson plan in grid view  

1. On the Grid view, select the lesson plan you want to copy. 
2. Click Copy. 
3. Select an existing lesson plan or create a new one. 
4. Click Paste. You can paste the copied lesson plan to as many subjects as needed.  

 
Copy a lesson plan from another teacher in grid view 

1. On the Grid view, from the Teacher drop-down menu, select the teacher from which you want to copy 
lesson plans. 

2. You can select a date range of lesson plans to display. 
3. Select the lesson plan you want to copy. 
4. Click Copy. 
5. From the Teacher drop-down menu, select your name. 

6. To create a new lesson plan, click New . 
7. Select a subject and date. 
8. Click OK. 
9. In the new lesson plan, click Paste. 
10. Click Save. 
11. To copy more lesson plans from other teachers, repeat steps 1-10. 
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Print Your Lesson Plans 
 
You can print your lesson plans by month, week, or day. 
 
To print your lesson plans, on the Home screen, click Lesson Plans. On the toolbar, click Print, and make a 
selection from the drop-down list. 
 
If you want to access more options for viewing and printing your lesson plans, you can print a report. 

1. On the Home screen, click Reports. 
2. Click to expand the Lesson Plans list and click a report. 
3. Select the report options and enter a date. 
4. On the toolbar, click Print.  
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Add an Assignment Type 
 
You can set up assignment types to use for your classes and the percentage of the final grade that each type 
represents. 

1. On the Home screen, click Options. 
2. Click Assignment Setup. 
3. Click Add. The Default Assignment Type dialog box displays. 
4. Select a teacher name from the drop-down list. 
5. Enter an assignment type, such as Homework, Classwork, Test, or Quiz. 
6. Enter a default weight for the assignment type, such as 50 or 10. 

 

  

Useful Information: The default weight represents what percentage of the final grade the Assignment Type make 
up. Example: A test can count 80% of the final grade.  
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Add an Assignment 
 
Once you add assignments to your classes, they're automatically entered into your gradebook. 

1. On the Home screen, click Assignments. 
2. On the toolbar, click New. The New Assignment dialog box displays. 
3. Enter the new assignment information and click OK.  
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Copy Assignments 
 
You can copy assignments from one class to another. 

1. On the Home screen, click Classes. 
2. In the Class List, select the class you want to copy assignments to. 
3. On the toolbar, click Edit. 
4. Click the Assignments tab and make a selection from the Subject drop-down list. 
5. Click Copy. The Copy Assignments dialog box displays. 
6. You can use the filter options to view a specific group of assignments. Select the check box next to each 

assignment that you want to copy. 
7. Click OK.   
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Post Assignment Grades 
 
Here's how you can post the assignment grades. 

1. On the Home screen, click Post Grades. 
2. On the left sidebar, select the class that you want to post grades for. All of the assignments that have been 

entered for the class display in the appropriate grading period. 
3. On the toolbar, click the Grading Period drop-down list and select a grading period. 
4. Enter grades for the assignments. After you enter all grades for one assignment, to move to the next 

student, press Enter on your keyboard. 
5. When you're finished entering grades, click OK. 

 

 

  

Useful Information: If the assignments don’t display, on the toolbar, click Customize and select the Show 
Assignments check box.  
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Mark Skill Grades for Students 
 
Many schools track skills along with grades, especially lower schools. For example, a first-grade student may have a 
math grade, as well as grades for different math skills such as adding and subtracting. 
 
You have the ability to track skills along with your subjects, and to print skills and skill grades on report cards. 

1. On the Home screen, click Skills. The Skill Grades dialog box displays. 
2. Select a class and grading period. 
3. In the Students list, click to select a student. A list of skills for each of the student’s classes appears on the 

right. 
4. Select the grade for each skill from the drop-down lists. 
5. Repeat steps 3 and 4 for each student. 
6. When finished marking skill grades, click Close.  
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Post the Class Attendance 
 
You can post your class attendance with the seating chart. You must arrange your seating chart first before you can 
post attendance with it.  

1. On the Home screen, click Classes. 
2. Select a class.  
3. On the toolbar, click Seating Chart. 
4. Click         to display the attendance status on the student desk icons.  
5. Right-click a student desk icon and select an attendance status.  

 

 
 

  

Tip: If you want to use the seating chart to mark attendance for all of your classes, on the Home screen, click 
Options > Seating Chart. Select the Use seating chart to mark class attendance check box.  
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Arrange the Seating Chart 

 
You can arrange your seating chart with student desk icons. You can also post attendance with the seating chart. 

1. On the Home screen, click Classes. 
2. Select a class. 
3. On the toolbar, click Seating Chart. 
4. Drag-and-drop the student desk icons where you want them.  
5. To save your seating chart, click Save Positions. 

 

  

Useful Information: You can right click on the teacher’s desk to rotate it. You can also right click in an empty area 
to access the options to resize the desk icons or auto arrange them. If you’re using a mobile device and 
experience problems with getting the right-click function to work, you can resize the desk icons by navigating to 
the Home screen > Options > Seating Chart. 
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Set Up Your Correspondence 
 
You can compose letters, email, or other document types with the Correspondence tool. Be aware that when you're 
emailing documents that are longer than one page, you should use the Attach File option. We recommend not 
exceeding a 5MB file size. 

1. On the Home screen, click Correspondence. 
2. On the toolbar, click New. 
3. Enter general information and notes for the correspondence. 
4. Click Create. The Rich Text Editor displays. 
5. Enter your letter in the Rich Text Editor. All fields available for mail merge are listed on the right side of the 

window. To select a field, double-click the field name. 
6. When you complete the letter, click OK. 
7. To save the correspondence, click OK. 

 

  

Useful Information: As a teacher, you’ll be able to correspond with other teachers and staff. Under Student and 
Parent correspondence, you’ll be able to select only students enrolled in your class and the parents associated 
with them.  
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Add a Behavior 

 
You can enter and store behavior information about students. 

1. On the Home screen, click Behavior. 
2. On the toolbar, click New. 
3. Enter general information and notes. 
4. Click OK. 
5. Select the Completed check box if the school's response to the behavior is completed.  
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Add a Reminder 
 
You can add a reminder to keep track of events or appointments you have on specific days. 

1. On the Home tab, click Reminders. 
2. On the toolbar, click New. 
3. Enter the general information and notes. If the reminder is done, select the Completed check box. 
4. Click OK. 

 

 
 

  

Tip: Reminders can also be added from the Calendar tab. To add a reminder to the Calendar tab, right click a date 
on the calendar and select Reminder.  
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Print Your Class Roles 
 
You can print your class roles for your own reference. 

1. On the Home screen, click Classes. 
2. Double-click a class name. 
3. On the Class Roll tab, click Print. 

 

  

Useful Information: If you don’t have access to the print option, see your HeadMaster administrator.  
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Add Teacher Comments to Report Cards 
 
As a teacher, you can add report card comments for each student. 

1. On the Home screen, click Post Grades. 
2. On the left sidebar, select a class. 
3. Select a student from the list and click inside the grading period you want to enter notes for. 
4. At the bottom of the window, enter your comments for that student. 
5. Click OK. 

 
You can also manage comments that you use often, such as "Great job!" and add them to the report cards. 

1. On the Home screen, click Post Grades. 
2. On the left sidebar, select a class. 
3. Select a student from the list and click inside the grading period you want to enter notes for. 
4. At the bottom of the window, click Manage. The Select/Manage Comments dialog box displays. 
5. Click Add. The New Comment dialog box displays. 
6. Type your comment and click OK. 
7. In the Select/Manage Comments dialog box, select the comment you want to add. 
8. Click OK. 

 

  

Useful Information: If you want to add the comment for the selected assignment to all students in the class, click 
Apply to All. Otherwise, repeat steps 1-8 for each student. 
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Email Class Roster Reports 
 
In order to avoid excessive printing, you can email your class rosters. 

1. On the Home screen, click Reports. 
2. In the Report List, double-click Rosters, and select Class Roster. 
3. Make your sorting and filter selections, and on the toolbar click Print to File. The Print to File dialog box 

displays. 
4. Browse to the location where you want to save the file. 
5. Click the File Type drop-down arrow and select what kind of file you want to save the class roster as. 
6. Click Export. 
7. You can attach the file to an email.  
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Post Your Class Announcements 
 
Teachers can enter and publish announcements for their classes. Enter the announcements in HeadMaster, then 
upload them to HeadMaster Online (the HMOnline option in the File menu) so that parents and students can view 
them the next time they log in. 

1. On the Home screen, click Announcements. 
2. Click New. The Announcement dialog box displays. 
3. Enter the Title, such as “Candy Sales End Tomorrow!” 
4. Enter a Publish Date. This is the first day that you want the announcement to be available online. 
5. Enter an Expiration Date. This is the last day you want the announcement to be available online. 
6. If it is applicable, select a Class. For example, if the announcement should appear for the whole school, leave 

the default <None>. If the announcement should be limited to a single grade or class, select the appropriate 
grade or class from the list. 

7. If there is a website to refer a parent to for more announcement details, enter the full address in the Web 
Link field. 

8. Enter any notes you want in the Notes field. 
9. Click OK. 
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	4. Enter grades for the assignments. After you enter all grades for one assignment, to move to the next student, press Enter on your keyboard.
	5. When you're finished entering grades, click OK.

	Mark Skill Grades for Students
	Many schools track skills along with grades, especially lower schools. For example, a first-grade student may have a math grade, as well as grades for different math skills such as adding and subtracting.
	You have the ability to track skills along with your subjects, and to print skills and skill grades on report cards.
	1. On the Home screen, click Skills. The Skill Grades dialog box displays.
	2. Select a class and grading period.
	3. In the Students list, click to select a student. A list of skills for each of the student’s classes appears on the right.
	4. Select the grade for each skill from the drop-down lists.
	5. Repeat steps 3 and 4 for each student.
	6. When finished marking skill grades, click Close.

	Post the Class Attendance
	You can post your class attendance with the seating chart. You must arrange your seating chart first before you can post attendance with it.
	1. On the Home screen, click Classes.
	2. Select a class.
	3. On the toolbar, click Seating Chart.
	4. Click         to display the attendance status on the student desk icons.
	5. Right-click a student desk icon and select an attendance status.

	Arrange the Seating Chart
	You can arrange your seating chart with student desk icons. You can also post attendance with the seating chart.
	1. On the Home screen, click Classes.
	2. Select a class.
	3. On the toolbar, click Seating Chart.
	4. Drag-and-drop the student desk icons where you want them.
	5. To save your seating chart, click Save Positions.

	Set Up Your Correspondence
	You can compose letters, email, or other document types with the Correspondence tool. Be aware that when you're emailing documents that are longer than one page, you should use the Attach File option. We recommend not exceeding a 5MB file size.
	1. On the Home screen, click Correspondence.
	2. On the toolbar, click New.
	3. Enter general information and notes for the correspondence.
	4. Click Create. The Rich Text Editor displays.
	5. Enter your letter in the Rich Text Editor. All fields available for mail merge are listed on the right side of the window. To select a field, double-click the field name.
	6. When you complete the letter, click OK.
	7. To save the correspondence, click OK.

	Add a Behavior
	You can enter and store behavior information about students.
	1. On the Home screen, click Behavior.
	2. On the toolbar, click New.
	3. Enter general information and notes.
	4. Click OK.
	5. Select the Completed check box if the school's response to the behavior is completed.

	Add a Reminder
	You can add a reminder to keep track of events or appointments you have on specific days.
	1. On the Home tab, click Reminders.
	2. On the toolbar, click New.
	3. Enter the general information and notes. If the reminder is done, select the Completed check box.
	4. Click OK.

	Print Your Class Roles
	You can print your class roles for your own reference.
	1. On the Home screen, click Classes.
	2. Double-click a class name.
	3. On the Class Roll tab, click Print.

	Add Teacher Comments to Report Cards
	As a teacher, you can add report card comments for each student.
	1. On the Home screen, click Post Grades.
	2. On the left sidebar, select a class.
	3. Select a student from the list and click inside the grading period you want to enter notes for.
	4. At the bottom of the window, enter your comments for that student.
	5. Click OK.
	You can also manage comments that you use often, such as "Great job!" and add them to the report cards.
	1. On the Home screen, click Post Grades.
	2. On the left sidebar, select a class.
	3. Select a student from the list and click inside the grading period you want to enter notes for.
	4. At the bottom of the window, click Manage. The Select/Manage Comments dialog box displays.
	5. Click Add. The New Comment dialog box displays.
	6. Type your comment and click OK.
	7. In the Select/Manage Comments dialog box, select the comment you want to add.
	8. Click OK.

	Email Class Roster Reports
	In order to avoid excessive printing, you can email your class rosters.
	1. On the Home screen, click Reports.
	2. In the Report List, double-click Rosters, and select Class Roster.
	3. Make your sorting and filter selections, and on the toolbar click Print to File. The Print to File dialog box displays.
	4. Browse to the location where you want to save the file.
	5. Click the File Type drop-down arrow and select what kind of file you want to save the class roster as.
	6. Click Export.
	7. You can attach the file to an email.

	Post Your Class Announcements
	Teachers can enter and publish announcements for their classes. Enter the announcements in HeadMaster, then upload them to HeadMaster Online (the HMOnline option in the File menu) so that parents and students can view them the next time they log in.
	1. On the Home screen, click Announcements.
	2. Click New. The Announcement dialog box displays.
	3. Enter the Title, such as “Candy Sales End Tomorrow!”
	4. Enter a Publish Date. This is the first day that you want the announcement to be available online.
	5. Enter an Expiration Date. This is the last day you want the announcement to be available online.
	6. If it is applicable, select a Class. For example, if the announcement should appear for the whole school, leave the default <None>. If the announcement should be limited to a single grade or class, select the appropriate grade or class from the list.
	7. If there is a website to refer a parent to for more announcement details, enter the full address in the Web Link field.
	8. Enter any notes you want in the Notes field.
	9. Click OK.


